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Introduction and Overview

Introduction
Welcome to the installation manual for the Tek-CARE160 Nurse Call System. This system
is designed to be low cost, easy to install, and extremely reliable. This manual will walk you
through the installation and configuration process, and will cover system operation as well as
common troubleshooting steps.
If you have questions at any point during the installation process, contact our Technical Sup-
port Department by email at teksupt@tektone.com or by phone at 800.327.8466 or
828.524.9967. Choose Option 3 for Technical Support.

Overview
The Tek-CARE160 system is a versatile system that can satisfy the needs of a wide range of
facilities. At its core, the Tek-CARE160 system is a four-wire nurse call system designed for
easy installation and years of trouble-free operation. The system is available with a variety of
call stations such as two-button pull-cord stations, 1/4" jack call cord stations, duty stations,
dome lights, and more.
In addition to these items, the Tek-CARE160 system can be easily integrated with existing
TekTone nurse call systems, nurse call systems manufactured by other companies, as well as
a wide variety of building systems such as fire alarm systems, security and access control
systems, and much more.
The Tek-CARE160 system may be used as either a standalone nurse call system using
NC415G3/NC404TS Master Stations, or it may be connected to other TekTone nurse call
systems, such as the Tek-CARE400 family, Tek-CARE570, or Tek-CARE750 over the Tek-
CARE Network. With the addition of the LS601 Tek-ALERT Integration Manager, the Tek-
CARE160 system is capable of communicating with many other types of building systems,
such as fire alarm and security systems. The LS601 Tek-ALERT Integration Manager also
allows the system to display and log various events from older analog TekTone nurse call
systems such as the Tek-CARE NC110, NC150, NC200, and 300/III systems.
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Product Overview

NC160 Central Equipment Module: The Tek-CARE160 system's main
component is the NC160 Central Equipment (CE) Module. The CE module
is designed to be stackable or rack mountable. The NC160 CE Module can
operate as a standalone system, or as a module on a larger, integrated Tek-
CARE nurse call system. The NC160 CE Module provides connections for
64 room controllers, and six NC415G3 or ten NC404TS Master Stations.
Multiple CE modules may be networked together to create a larger system.

NC415G3 Master Station: The NC415G3 Master Station is a touchscreen
master station that is used to interact with the Tek-CARE160 system. The
NC415G3 Master Station displays calls from the Tek-CARE160 system and
provides limited programming and configuration ability for the Tek-
CARE160 system. The NC415G3 uses a five-inch LCD touchscreen to
provide audible and visual annunciation of system calls. The NC415G3
may be mounted using the IH415D desk stand or wall-mounted using the
IH415W wall-mount bracket.

NC404TS Master Station: The NC404TS Master Station is a touchscreen
master station that is used to interact with the Tek-CARE160 system. The
NC404TS Master Station can display maps and calls from the Tek-
CARE160 system and provides programming and configuration ability for
the Tek-CARE160 system. The NC404TS uses a 24-inch LCD touchscreen
to provide audible and visual annunciation of system calls. The NC404TS
may be mounted using the CL231 bracket.

LI122UN Room Controller: The LI122UN Room Controller provides con-
nections for six Tek-CARE160 stations and one connection for the Tek-
CARE160 data bus. In most instances, the room controller is installed out-
side a room in the same position as a traditional dome light. The two-con-
ductor cable is used to connect Tek-CARE160 stations to the LI122UN
Room Controllers. The rear of the room controller contains a 14-pin header.
Pins 1-12 are used in pairs for station connections, and pins 13 and 14 are
used to connect the room controller to the Tek-CARE160 data bus. The
LI122UN annunciates high priority calls with red or blue LEDs and low pri-
ority calls with white LEDs. The LED colors can be changed on the room
controller.

NOTE: A slot is provided at the seam between the
dome light plastic base and lens faceplate to aid in
separating the two parts whenever the need arises.
Place a flat-head screwdriver or similar tool into the
slot to lift off the faceplate.

PM120 Room Controller: The PM120 Room Controller provides con-
nection points for Tek-CARE160 stations without the dome light LEDs
found on the LI122UN Room Controllers. The PM120 is designed to be
installed out of sight.
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IR160 Audio Station: The IR160 Audio Station provides a speaker and
microphone for two-way communication between facility staff and res-
idents. The IR160 requires a connection to the LI122UN Room Controller
(using one point) and a connection to the Tek-CARE160 Audio Bus cable.
The IR160 Audio Station can be installed as a standalone speaker, but is
most commonly installed with an SF121 or an SF123 series station in an
IH122K dual gang housing. The IR160 shown to the left is shown with a
SF121 Patient Station.

SF121 and SF122 Patient Stations: The SF121 Patient Station is designed
to provide a single 1/4" jack for standard call cords. The SF121 mounts
near a resident’s bed or chair, and enables calls to be placed using push-
button call cords, geriatric call cords, pneumatic call cords, and more. The
SF121 is equipped with an illuminated reset button. The SF122 Patient Sta-
tion is a dual-jack version of the SF121.

SF123 Customizable 2-Button Pull-Cord Station: The SF123 station is
used to place a variety of calls on the Tek-CARE160 system. The SF123
uses interchangeable inserts depending on the desired function of the sta-
tion. The SF123 is most commonly used as an Emergency station, but can
be easily configured for Bath, Code Blue, and Emergency 2 calls. Custom
call types may also be created, and custom call type inserts can be gen-
erated using the LS450 ConfigTool software. The SF123 can also be used
as a room-level reset button and a check-in station. Use the RP187K Gasket
Kit for mounting in wet environments.

IR160V Remote Speaker/Microphone Panel:The IR160V panel separates
audio from another station. Use the connected station’s onboard jumper to
enable an IR160V for audio (this will deactivate audio on the connected sta-
tion).

A connected station can be located outside the ward, with an IR160V
Remote Speaker/Microphone Panel and an SF123V Vandal 2-Button Sta-
tion inside the ward.

SF123V Vandal 2-Button Station: The SF123V Vandal 2-Button Station
has two large, low-profile, vandal resistant push buttons for Call and
Cancel, and is also equipped with a call assurance LED.

The SF123V serves as a peripheral staff emergency switch when used with
a staff emergncy station. Up to six peripheral SF123V 2-Button Stations
may also be located within the ward to provide additional call points.

Copyright © TekTone Sound and Signal Mfg., Inc. All Rights Reserved IL1024 Tek-CARE160 Installation Manual | 7

Introduction and Overview



Introduction and Overview

SF123PSY Psychiatric 1-Button Station: The SF123PSY is used with the
SF336A; activating the SF336A outside the ward enables the staff emer-
gency station inside the ward, plus all associated SF123PSY stations, and
places an Enabled call at the master station. The in-use LED on the key
switch indicates that the ward’s staff station and emergency switches are
on.

If a staff member requires emergency assistance, using the station or any of
the emergency switches places a high priority call to the master station.
Call placement is indicated by an LED on the staff station or emergency
switch.

SF336A Vandal Key Switch: Activating the SF336A Key Switch outside
the ward enables the staff emergency station inside the ward, plus all asso-
ciated SF123V/PSY switches, and places an Enabled call at the master sta-
tion. The in-use LED on the key switch indicates that the ward’s staff
station and emergency switches are on.

SF125 Duty Station: The SF125 is a duty station used to alert staff to
pending Tek-CARE160 system calls. The duty station is installed in areas
where call annunciation is needed, but the full functionality of a master sta-
tion is not. Four LEDs communicate the type of active call, and an audible
tone alerts staff members when calls are placed. The SF125 duty station
uses two points on the LI122UN Room Controller or PM120 Room Con-
troller.

PM123 Auxiliary Input Module: The PM123 is a module used to monitor
normally open dry contacts such as door switches, emergency pushbuttons,
and alarm contact outputs. The PM123 is designed to be installed out of
sight. Up to two individual contacts can be monitored with a single PM123.
The PM123 may also be used as an auxiliary check-in device. Normally
open contacts such as door switches, motion detectors, or pressure pads
may be used with the PM123 to satisfy a resident check-in requirement on
the system.

CT160 Cable Adapter (CT160K pictured - CT160 with housing): The
CT160 is designed to adapt a connection from a two-wire flying lead to an
8P8C connector. The CT160 may be connected to LI122UN and PM120
Room Controllers or can be ordered as the CT160K which includes hous-
ing.

SF126DC Dry Contact Output Module: The Normally Open (N.O.) Dry
Contact Output Module provides a two-pin header for a relay/device con-
nection and another for the station connection. Upon initiation it will
provide one of four programmable output behaviors; from the master sta-
tion, either a 5-second on or a toggle on/off output, or at the station, a local
or zone output. The SF126DC can be mounted individually or with another
SF120 peripheral, depending on the application.
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Installation

Installation for the Tek-CARE160 system is designed to be very straightforward. The data bus is designed
to operate on unshielded 18/2 AWG twisted cable or on CAT5e or better cabling. The audio bus is designed
to operate on CAT5e or better cabling.
When making wiring connections, use quality crimp connectors such as Dolphin® Super B® connectors.
Do not use wire nuts. Adequately protect all splices using junction boxes.

Installation Workflow:
o Install all NC160 CE Modules.
o Install the backup batteries.
o Run data and audio bus wiring through the facility.
o Install and address LI122UN/PM120 Room Controllers.
o Connect the audio bus to IR160 stations.
o Run master bus wiring and make 8P8C terminations.
o Check data bus for shorts and connect master and data bus wiring to the NC160 CE Module.
o Power on the NC160 CE Module.
o Create a configuration using the LS450 ConfigTool software.
o Test the Tek-CARE160 system.
o Back up the configuration and turn the system over to the facility.

Types of Installation
There are two types of installations available for the Tek-CARE160 system, a One-to-One installation and a Cus-
tom installation.

One-to-One
A one-to-one installation strategy involves installing a single LI122UN Room Controller outside of each
room in the facility and using the points on that room controller to connect to stations installed in that
room.
In this installation strategy, stations are normally wired to their default points on the room controller. The
room controller will then annunciate calls from its attached stations only.

Custom
In a custom installation, each point on a room controller can be reassigned to a unique Station ID. This
enables the room controller to drive stations installed in different rooms. A custom installation strategy also
enables a single room controller to drive multiple patient stations in a single area, such as a ward.

NOTE: Custom installations require training and a ConfigTool Plus or ConfigTool Elite
license.
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Installation Concerns
When installing the Tek-CARE160 system, organization is key. As you install the system, note the DIP
switch address of each room controller, the physical location of the room controller, and which stations are
connected to the room controller on each point.
Keeping detailed records throughout the installation process will greatly simplify system programming and
setup. A programming worksheet is included at the end of this manual.

Below is an example of a completed programming worksheet.

Power Considerations
In order to stay within the power limits of the NC160 CE Module and ensure reliable system performance,
the Tek-CARE160 Power Calculator will calculate the master load for the module. The calculate may be
downloaded at:
http://www.tektone.com/pdf_files/GEN2_master_station_load_value_calculator.xlsx
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Figure 1 - NC160 CE Module Connections
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The NC160 Central Equipment Module
The NC160 Central Equipment Module contains all necessary connections for the Tek-CARE160 hardware
as well as the backup batteries for the system. The NC160 CE Module is designed to be mounted in a stand-
ard 19" server rack using included CL120RM brackets. Modules may also be desk-mounted and stacked.
The NC160 CE Module requires 120VAC or 240VAC power, and must be connected to a generator-backed
circuit intended for life safety equipment.
If the NC160 CE Module is not mounted in a server rack, allow adequate air space around the front, sides,
and back of the unit. At least 6" of airspace must be maintained for the unit to operate reliably. Refer to -
NC160 CE Module Connections on the previous page for NC160 CE port descriptions.
On the front of the NC160 CE Module, you will find a bank of DIP switches. These DIP switches are used
to configure various options on the CE module and to provide an address for the CE module.
The two-position DIP switch indicated by the STA/LOC is for future use, and both DIP switches should be
turned OFF. If either switch is turned on when the module boots up, the NC160 CE Module will return an
LED error code 30 (PORT_MODE_NOT_SUPPORTED). The yellow and red LEDs will be lit, and the
green LED will flash a two-digit code.
The small bank of 4 DIP switches on the left is used for the following functions. Note that the down pos-
ition of the switch is on. Normal settings are indicated in parenthesis.

Figure 2 - Module DIP Switch Addressing
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Switch 1 – Redefault the database. (Off/Up)
Switch 2 – Silence the audio alarm buzzer. (On/Down)
Switch 3 – Redefault network subnet assignment to 192.168.1. (Off/Up)
Switch 4 – Factory and troubleshooting use only. (Off/Up)
The second bank of 8 DIP switches is used to set the address of the NC160 CE Module.
Switch 1 – Switch 7 – Used to select the CE module’s address. Valid addresses are 1-75. Note that though
there are 75 available DIP switch addresses, no more than 20 modules may be installed on a single Tek-
CARE system. Switch 1- Switch 7 utilize standard binary addressing, with Switch 1 being 1 and Switch 7
being 64.
Switch 8 – Factory Use Only. (Leave turned Off/Up)

Install Backup Batteries
Before proceeding with system setup, install the backup batteries in the module. Open the two-battery com-
partment covers on the top of the module.
Locate the red (positive) and black (negative) wires with female spade connectors under each door. Move
the wires out of the way and place the batteries in the holders and connect the spade terminals to the bat-
teries as shown below.
Connect the red leads to the positive terminal of each battery and the black leads to the negative terminal of
each battery.

Figure 3 - Battery Connections

The Tek-CARE160 Data Bus
The Tek-CARE160 data bus is a two-wire serial communications bus. There are four ports on the front of
the module, each capable of driving up to 1,000 feet of data bus and up to 16 LI122UN Room Controllers.
There are four 8P8C jacks on the front of the module. The two on the right are for NC415G3/NC404TS
Master Stations, and two on the left for Tek-CARE Network connectivity. Each module supports up to six
master stations, three per port.
To begin installing the NC160 CE Module, mount the module either on a server rack or on a shelf. Plug in
the supplied AC power cord, and turn the unit on. You are now ready to begin connecting field wiring to
the module.
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Tek-CARE160 Installation Considerations
Note that the audio bus on the Tek-CARE160 system is analog, and thus, only supports one concurrent
audio connection per port.
For example, if a facility has IR160 stations in rooms 100-110 connected to Port 0 and rooms 111-160 con-
nected to port 1, one NC415G3/NC404TS Master Station could connect audio to room 100 and another
NC415G3/NC404TS Master Station could connect audio to room 111. If a master station attempts to con-
nect to an audio bus that is already in use, the connection will fail.
When installing cabling, be sure to keep the audio bus and the data bus for each port together. Remember
that the IR160 requires a connection to the room controller and the audio bus. If the IR160 is connected to a
room controller that uses Data Bus Port 0, but the audio bus for that IR160 connects to Port 1, the audio
connection will not function.

Figure 4 - Audio Bus and Controller Connections
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Figure 5 - Typical Room with One IR160 Audio Station

Figure 8: Typical Room with one IR160 Audio Sta-
tion
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Audio Connection Considerations
The most common scenario for installing the Tek-CARE system is to have a single IR160 Audio Station
associated with a single room controller, and thus, a single Station ID.
Up to four IR160 Audio Stations may be associated with a single Station ID; however, all IR160s asso-
ciated with a Station ID will open their audio connections simultaneously.
Example 1
In the example shown in Figure 5 on page 15, a single LI122UN room controller is installed outside of the
room. An SF122 is connected to Point 1, an SF123 is connected to Point 4 (creating a Bath call) and an
IR160 is connected to Point 6. Note that the audio cable never connects to the room controller.
In this example, all three stations are associated with a single Station ID, meaning that any call from this
Station ID (SF122 or SF123) is answered at the master station, the audio channel opens.
Example 2
The example shown in Figure 7 on page 21 illustrates a slightly different wiring scheme utilizing the same
room layout. In this example, everything is the same as before except there is an additional IR160 installed
in the bathroom. Again, in this scenario, all four stations are connected to a single room controller, and asso-
ciated with a single Station ID.
In this scenario, a call from either the SF122 Patient Station or the SF123 Bath Station will open audio to
both IR160 stations. This scenario requires that the system be manually configured to expect an IR160 con-
nected to Point 5.
Example 3
If unique audio in each location is desired, a Plus or Elite license is required for the LS450 ConfigTool Soft-
ware. This enables the points of one controller to be assigned to different Station IDs.
Returning to Figure 7 on page 21, if the facility requires unique audio connections at both the bed and the
bath areas, simply assign Points 1 and 6 of the room controller to a Station ID (e.g., RM 100) and the other
two points to a different Station ID (e.g., 100 BATH).
Once the points have been reassigned, answering calls or dialing each Station ID will only open audio at
the IR160 that is associated with that Station ID.
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SF120-series Peripheral Devices for Addressable Stations (General
Information)
There are 6 points which are the 6 physical connections on the rear of each addressable station.
The SF120-series peripheral devices′ electronics are mounted on flame-retardant (UL® 94V-0) plastic face-
plate. Mount each SF120-series peripheral device within 100 feet of the addressable station to which it is
connected. Up to six peripherals may be connected to each addressable station. These devices are typically
mounted on single-gang rings or boxes. The operating environment is 0°C–60°C.

SF121 Single Patient Station and SF122 Dual Patient Station
The SF121 is a 1/4" jack call station that provides a secondary call location (i.e., room chair). The SF122 is
a dual-jack version of the SF121.

SF123 Customizable 2-Button Pull-Cord Station
The SF123 station is used to place a variety of calls on the system. The SF123 uses interchangeable inserts
depending on the desired function of the station. The SF123 is most commonly used as an Emergency sta-
tion, but can be easily configured for Bath, Code Blue, and Emergency 2 calls. Custom call types may also
be created, and custom call type inserts can be generated using the LS450 ConfigTool software. The SF123
can also be used as a room-level reset button and a Check-in station. Use the RP187K Gasket Kit for mount-
ing in wet environments, such as showers, baths, or tub rooms.

IR160 Audio Station
The IR160 Audio Station provides a speaker and microphone for two-way communication between facility
staff and residents. IR160 Audio Stations require two connections, one to the two-pin header that connects
to the addressable station, and one for audio connection.

IR160V Vandal Remote Speaker/Microphone
The IR160V Remote Speaker/Microphone Panel provides two-way audio communication with resident
room. The IR160V is also equipped with audio LED that illuminates with audio connection, and has a steel
mesh for speaker protection.

SF123V Vandal 2-Button Station
The SF123V Vandal 2-Button Station has two large, low-profile, vandal resistant push buttons for Call and
Cancel. The SF123V is also equipped with call assurance LEDs.

SF123PSY Vandal 1-Button Station
The SF123PSY Vandal 1-Button Station has one push button for placing a call and no means of resetting it
in the room, to properly outfit a pysch room where there should not be a reset button. The SF123PSY is
used with the IR436G3 Psychiatric/Vandal Staff Emergency Station.

Copyright © TekTone Sound and Signal Mfg., Inc. All Rights Reserved IL1024 Tek-CARE160 Installation Manual | 17

Installation



Installation

SF336A Vandal Key Switch
When the IR436G3 is used as a Psychiatric/Vandal Staff Emergency Station, the SF336A will place a call
and enable the SF123V in the room.

PM123 Auxiliary Input Module
The PM123 is a module used to monitor N.O. Dry Contacts such as door switches, emergency pushbuttons,
and alarm contact outputs. The PM123 is designed to be installed out of sight. Up to two individual con-
tacts can be monitored with a single PM123. The PM123 may also be used as an auxiliary check-in device.
N.O. Contacts such as door switches, motion detectors, or pressure pads may be used with the PM123 to
satisfy a resident check-in requirement on the system.

SF124 Staff Peripheral Station
The SF124 station has four configurable push-buttons. The functions of the SF124 include staff presence,
staff request and staff rounding with programmable schedules. For more information on the rounding fea-
ture, refer to IL855 LS450 ConfigTool Manual. Keep peripheral station wiring to 50 feet.
Current button layout options:

l L1, L2, Staff Emergency, L3 (Default)
l L1, L2, Staff Emergency, Reset
l L1, L2, L3, Reset
l L1, Code, Staff Emergency, Reset
l Rounding, Code, Staff Emergency, Reset

Button labels can be generated within the LS450 ConfigTool under Tools>Generate Label Images. Go to
the Points page to configure the point that is wired to the station. Then select the SF124 and choose the
desired function for the presence station.

NOTE: There is no default point specifically assigned to the SF124. TekTone suggests using
point 6 (green/green-white), which will not create a call/fault until properly programmed as
points 1-5 will.

Once finished with the Points page, click Apply and save the configuration.
To place a presence call on the station, press the button once. To clear the presence, press the button again.
To place a request call, press and hold down the button. Press the button again to reset the call in the room.
If there is an ongoing routine bed call, pressing the presence button will set a presence status and clear the
bed call.
When the rounding button behavior is selected, the button can be used in conjunction with programmed
schedules to provide a staff rounding function.
If a button configuration that includes RESET has been applied, pressing it will clear all active calls in the
room.

SF126DC Dry Contact Output Module
The N.O. Dry Contact Module provides a two-pin header for a relay/device connection and another for the
station connection. Upon initiation it will provide one of four programmable output behaviors; from the
master station, either a 5-second on or a toggle on/off output, or at the station, a local or zone output.
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The SF126DC can be mounted individually or with another SF120 peripheral, depending on the applic-
ation. Use applications for the SF126DC may include:

o Triggering an input on a security alarms panel for offsite monitoring
o Activating strobes and sirens
o Activating pre-recorded messages on 3rd-party equipment

Wiring Installation
Tek-CARE160 Data Bus Wiring
The main wiring for the Tek-CARE160 system consists of a two-wire communications data bus. The data
bus ports on the front of the NC160 CE Module are capable of supporting 16 room controllers each, for a
total of 64 controllers per module. Note that each port is capable of driving up to 1,000' of cable for the
data bus. TekTone recommends 18/2 stranded cable for the data bus, but other types of wiring are accept-
able. See the table below for details.

NOTE: If 22 AWG cable is used, the data bus runs can be extended by twisting conductors
together at each splice. For example, 22/4 cable used for data bus wiring could have two con-
ductors twisted together for the positive leg of the data bus and two conductors twisted
together for the negative leg.

16 Controllers
Max

12 Controllers
Max

8 Controllers
Max

8 Controllers
Max

18 AWG Cable 1000' 1000' 1000' 1000'
20 AWG Cable 625' 800' 1000' 1000'
22 AWG Cable 350' 525' 750' 1000'

2 x 22 AWG Cable 775' 1000' 1000' 1000'
CAT5e with CT160 1000' 1000' 1000' 1000'

CAT5e Cabling Option
The CT160 is convenient for wiring from a module to room controllers. From the NC160CE, connect the
CT160 two-wire pigtail to the data bus on the port. Refer to Wiring for TC160 with CT160 diagram on the
next page. CT160 can either be installed as a standalone with the mounting hardware (CT160K), or it can
be snapped into the back of LI122UN dome lights and/or PM120 controller modules. Once installed, run or
reuse CAT5e or better cable plugged into the CT160 and out to each dome or module. Refer to Figure 9 on
page 23 to note the positive and negative connections. Test CAT5e connections and meter cables for shorts
and incorrect wiring to avoid issues later.
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Figure 6 - Wiring for TC160 with CT160
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Figure 7 - Typical Room with two IR160 Audio Stations
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Run wiring from room controller to room controller and connect the room controllers to the data bus in par-
allel using T-taps. Connect the positive wire in the data bus cable to the solid white wire (pin 13) on the
back of the room controller, and connect the negative wire from the data bus to the black wire (pin 14) on
the room controller.

NOTE: If using CAT5e cable, make sure to use the appropriate terminators and 8P8C con-
nectors.

Tek-CARE160 Audio Bus Wiring
The audio bus for the Tek-CARE160 system is designed to operate on CAT5e or better cable.
Maximum audio bus cabling distance, including drops to IR160 Audio Stations, must not exceed 1,000' on
each available port. Each IR160 station must be connected to the audio bus.
TekTone recommends pairing up an audio bus cable and data bus cable. For example, the data bus cable
from port 0A should be paired with the audio bus cable from port 0A. These cables should be pulled
together. Do not use a 4-conductor cable to combine the audio and data bus. This will produce
extreme audio interference and drastically impact audio quality.

IMPORTANT: Use care when running audio bus cable. If possible, avoid running the audio
bus cable near high voltage electrical cables. Also, try to neatly install the audio cable, avoid-
ing intertwining it with the data bus cabling.

An IR160 Audio Station will open an audio connection when a call placed by any SF121, SF122, SF123, or
PM123 assigned to the same Station ID as the IR160 is answered at a master station.
If a Station ID is dialed from the master station, an audio connection will be opened on all IR160s asso-
ciated with that Station ID.

Addressing Room Controllers and Default Behavior
The Tek-CARE160 system is designed to be simple to install. As such, the room controllers are designed so
that a basic system can be brought online with minimal programming.
Each room controller must be addressed to communicate on the data bus using the five position DIP switch
found on the back of the room controller. Available addresses are 0-31.
When assigning addresses to the room controllers, keep in mind which port the room controller is con-
nected to. For purposes of addressing, the two left data bus ports (0A and 0B) and two right data bus ports
(ports 1A and 1B) are tied together. This means that addresses for room controllers connected to port 0A
and port 0B must be unique, but port 0A and port 1A may have addresses duplicated between them.
Keep detailed notes of the physical addresses and locations of room controllers installed in the facility
using the worksheet in the back of this manual. Without adequate installation notes, system configuration
will be extremely time consuming.

NOTE: No terminating jumper or resistor is required on the data bus. If necessary, the data
bus may also be installed using a star topology. Do not exceed 1,000 feet of cable on any
one data bus run.

The address assigned to the room controller also influences the default behavior of the room controller. If a
controller is addressed as 0-29, the system assumes that the controller will be installed in a single bed con-
figuration. This is useful for simple one-to-one installations. Room controllers addressed as 30-31 are
defaulted to duty station behavior. These default behaviors are modified during configuration setup if
needed.
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Connect Stations
Up to six stations may be connected to each room controller using the header on the back of the room con-
troller. The leads on the header are paired together to form a point on the room controller. This means that
each header has six points to connect stations to, and one point for data bus connections.
With the wire leads on the connector pointing down, Point 1 is on the left. The illustration below shows the
six available points on the header. The point connections are arranged +-, +-, etc., with each group of +-
connections making up one point.

Figure 8 - Points Table

Figure 9 - Single Patient Station Default Room
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Figure 10 - Double Patient Station Default Room

Figure 11 - Duty Station Default Room Controller Points (Address 30-31)

Tek-CARE160 Station Wiring
When installing wiring to stations, use 22-18 AWG cable. Do not exceed 100 feet of cabling for SF121,
SF122, and SF123 stations. For SF125 stations, do not exceed 50 feet of cabling. Only one station may be
connected to each point. Do not splice multiple stations together on the same point wiring.
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One-to-One Installations
In most installations, one room controller will be used as a connection point for all of the station in the asso-
ciated room. This provides the simplest software configuration option, but other installation strategies are
available.
In a one-to-one installation, connect the stations to the room controller according to the Connect Stations
on page 23.

Custom Installations
In other cases, a single room controller can be used to connect stations from multiple rooms or several beds
in a ward-style installation. If stations are installed in this way, keep detailed notes that correlate the phys-
ical room the station is installed in and the DIP switch address of the room controller the stations are con-
nected to. This information will be needed when creating the system configuration.

LI122UN LED Color Configuration
The LI122UN Room Controller has two switches for the LED colors of the dome light. Choose between
red and white or blue and white LED options. The white LEDs are selectable for warm or cold hues. See
the figure below for more details on the appropriate switch positions.
For high priority calls, choose either red and white or blue and white by setting the switch to the left for red
or to the right for blue.
For low priority calls, the white LEDs can either have warm or cool hues selected by setting the switch to
the left for warm or to the right for cold.

Figure 12 - LI122UN LED Configurations

The default switch positions for the LI122UN are for red and cold.
IMPORTANT: Make sure to set the switch all the way over to one side or the other. Do not leave the
switch in the middle between the two color choices. This can prevent either color LED from activating.
If the switch is mistakenly set in the center, the LEDs will not show when calls are active.
The LED colors in the ConfigTool MUST match the color that has been configured on the LI122UN Room
Controller.
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Housing Considerations

Use an IH121K housing for a single SF12x or IR stations. Use an IH122K housing if installing an SF and IR sta-
tion together or putting together a blank panel. See individual spec sheets for mounting details.

Station Connection Instructions
IR160 Audio Stations: IR160 Audio Stations require two
connections, one to the audio bus and one to the LI122UN Room
Controller.
Connect the red wire on the IR160 to the positive wire of the desired
point on the room controller, and connect the black wire of the same
point.
Connect the violet wire on the IR160 station to the positive leg of the
audio bus. Connect the gray wire on the IR160 station to the
negative leg of the audio bus.

CAT5e Cabling Option: NC160 Audio Bus
The CT160K can also be used with the NC160 audio bus. Use a
CT160K at the central location to convert the audio bus from 2-wire
to CAT5e (or better) cabling terminated to the T568B standard.
IR160 speaker stations also support in and out 8P8C connections as
well. Please note this is for the audio bus only. A data bus
connection from the IR160 to the controller is still required.

SF121 Single and SF122 Dual Patient Stations: Connect the red lead from the station to the positive ter-
minal on the desired point of the room controller and connect the black lead to the negative terminal of the
desired point on the room controller. If possible, connect the patient station to Point 1. This is the default
connection point for patient stations in a single or dual bed installation.

Figure 13 - IR160 Connections
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SF123 Customizable Two-Button Pull-Cord Station: Slide the desired call type insert into the slot on the
front of the station. Snap the circuit board into the front bezel by spreading the face of the bezel while pla-
cing the circuit board into the retaining clips.
Install the rear bracket on the wall or junction box using the two screw holes in the bracket. If a pull string
is used, push an end of the pullstring through the hole in the slider contained on the bracket. Use the
included brass ferrule to crimp onto the string. Trim the string to the appropriate length and insert it through
the hole in the plastic handle. Crimp the remaining ferrule onto the string below the handle.

NOTE: Push the slider up into the retaining nibs on the rear bracket. Failure to push the
slider up and secure it will result in station damage during installation.

o To use an SF123 as a Code Blue switch, connect it to Point 2 (Blue and Blue/White) on the room
controller.

o To use an SF123 as a Bath Emergency switch, connect it to Point 3 (Red and Red/White) on the
room controller.

o To use an SF123 as an Emergency switch, connect it to Point 4 (Orange and Orange/White) on
the room controller.

o If a custom call type is desired, note which point the SF123 station is connected to using the work-
sheet in the back of this manual. This information will be used during configuration setup.

If an SF123 is to be used as a Check-In/Reset station, connect it to any unused point of the room controller.
Be sure and note the point that it is connected to, so it can be correctly programmed during configuration
setup. For more information about Check-In, see Room Level Reset on page 43.

SF125 Duty Station: Connect the red lead from the SF125 LED panel to the positive terminal of the
desired point on the room controller and connect the black wire to the negative terminal of the desired point
on the room controller. Connect the positive and negative leads from the toner module to another point. If
possible, connect the SF125 LED panel to Point 1, and the toner module (PM578SM) to Point 6. These are
the default point connections for a room controller set up with the duty station present.
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PM123 Auxiliary Input Module: Remove the top cover from the PM123 case. Inside, note the PM123 har-
ness and six wires. Connect the wiring from the room controller and switches to the PM123 Module. Con-
nect the positive terminal of the desired point on the room controller to the Send terminal, and connect the
negative point of the desired point to the Return terminal. If possible, connect the PM123 Module to point
5, which is the default connection point for the PM123.
Connect the normally open dry contact to be monitored to Contact 1 or Contact 2. There are three avail-
able functions for the PM123 in the ConfigTool, Aux Input 1 (with A and B sides), Aux Input 2 (with A
and B sides), and Aux Check In.
Note that Contact 1 will appear as Aux Input 1A or Aux Input 2A in the ConfigTool software depending
on the function selected. Contact 2 will appear as Aux Input 1B or Aux Input 2B. Aux inputs are non-
latching by default, but can be configured to be latching within the LS450 ConfigTool Software.

Figure 14 - PM123 Connections

The PM123 may also be used as a check in device. If a normally open dry contact is connected to Contact
1, and the contact is closed at any point during the check in window, the check in requirement will be sat-
isfied. If a device such as a motion detector or pressure pad is used for check in, connect the output from
the device to Contact 1.
If a normally open dry contact is connected to Contact 2 and changes state at any point during the check in
window, the check in requirement will be satisfied. This is useful if a door contact switch is to be used for
check in. In this instance, if the switch is closed at the start of the check in period, opening the switch at
any point during the check in period will satisfy the check in requirement.
For more information about check in, see Check In on page 43.
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SF126DC Dry Contact Output Module: The N.O. Dry Contact Module provides a two-pin header for a
relay/device connection and another for the station connection. Upon initiation it will provide one of four
programmable output behaviors; from the master station, either a 5-second on or a toggle on/off output, or
at the station, a local or zone output.
The SF126DC can be mounted individually or with another SF120 peripheral, depending on the applic-
ation. Use applications for the SF126DC may include:

l Triggering an input on a security alarms panel for offsite monitoring
l Activating strobes and sirens
l Activating pre-recorded messages on 3rd-party equipment

Figure 15 - SF126DC Connections
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SF120-Series Vandal/Psychiatric Stations: SF120-series Vandal stations are installed on a single-gang
ring with a dual-gang box. Connect the red lead from the station to the positive terminal on the desired
point of the addressable station and connect the black lead to the negative terminal of the desired point on
the addressable station.

NOTE: These devices require grounded backboxes. This is critical for protection against elec-
trostatic discharge (ESD).

NOTE: Consider additional depth required for cable connectors.

Figure 16 - SF120-series Vandal/Psychiatric Connections
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Connect NC415G3/NC404TS Master Stations
The two 8P8C jacks on the right side of the NC160 CE Module
are the connections for the NC415G3/NC404TS Master Stations.
Each jack supports three NC415G3 or five NC404TS Master Sta-
tions with no more than 1,000 feet of CAT5e or better cabling
on the run. Wire the 8P8C connectors for the NC415G3 Master
Stations according to the T568B standard.
To connect more than one NC415G3/NC404TS Master Station
to each port, use a CT400P5 splitter at any point along the mas-
ter station cabling run.

Figure 17 - T568B Standard Wiring

Much like room controllers, each NC415G3/NC404TS Master must also be assigned a unique address (0, 1,
2, 3, or 4) using the DIP switch on the rear of the master. The NC160 CE Module will automatically assign
a master name (e.g., 01M1) to each master. This name can be changed in the LS450 ConfigTool software.
Up to six NC415G3 or 10 NC404TS Master Stations may be connected to a single NC160 CE. Connect up
to three NC415G3 or five NC404TS masters to each 8P8C jacks labeled Master Station on the front of the
NC160 CE.
The last NC415G3 or NC404TS Master Station that is furthest away from the CE should have a DIP switch
5 on for the EOL resistor.

Figure 18 - NC415G3 Master Station Connections
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Figure 19 - NC404TS Master Station Connections

Figure 20 - NC403/4TS Monitor Connections
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Figure 21 - NC403/4TS Controller Port ID

For more information on connections for the NC404TS, see IL1052 NC404TS Installation Manual.
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Figure 22 - NTA415L Headset

TA415L Handset Kit If the NC415G3 Master will be equipped with handset audio, the TA415L handset kit
must be installed. Install the handset cradle on the NC415G3 Master using the two screws included with the
kit as shown. Connect the included coiled cord between the handset and the 4-pin jack on the rear of the
NC415G3.
Multicolor Zone Dome
If desired, a zone dome light (part number LI484P5) may be connected to the master station using the 6P6C
jack on the back. The zone dome light will illuminate whenever a call is present on the connected master
station.
Use CAT5e or better cabling to connect the LI484P5 to the NC415G3 Master Station and wire the 6P6C
with a straight-through configuration. Do not exceed 50 feet of cabling for dome light connection.
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Connect Data Bus Wiring
Before connecting the data bus wiring to the NC160 CE Module, check the data bus wiring for shorts. Con-
nect the positive wire in the data bus cable to the positive terminal on the NC160 CE Module port and the
negative wire in the data bus cable to the negative terminal on the NC160 CE Module using the included
plugs.
Note which station run gets plugged into which CE module port. This information will be needed when set-
ting up the system configuration.

Connect Audio Bus Wiring
Check the audio bus cabling for shorts before connecting it to the NC160 CE Module. Use the included con-
nectors to connect the audio bus cables to the audio ports on the face of the NC160 CE Module. Be sure
and note the polarity before making any connections. Remember to note which IR160 audio stations are
connected to which audio bus run.

Connect Master Bus Wiring
Connect the master bus cabling to the ports on the right side of the NC160 CE Module. Keep a record of
the locations of master stations and their automatically assigned names. Once the system is powered on for
the first time, go to each master station on the system and touch theMenu button on the home screen, then
touch the This Master button that appears. The top of the screen will display the default name of the mas-
ter station. Note this information, as well as the actual location of the master station for use during system
configuration.
If more than one NC415G3 or NC404TS Master Station is installed on a master bus run, use a CT400P5
splitter to provide multiple connections to a single master bus port.

NOTE: The final master station on each master bus should have its internal terminating res-
istor enabled. Turn DIP switch 5 on the rear of the NC415G3 or NC404TS Master Station
ON to enable the terminating resistor. See Figure 18 on page 31 for more information.

Networking Multiple NC160 CEModules
If multiple modules are to be networked together, use the DIP switches on the face of the modules to set
unique module IDs for each CE module as discussed in The NC160 Central Equipment Module on page
12.
Once each module has been assigned a unique address, connect the modules to each other using the Net-
work Ethernet jacks on the left side of the units. Modules are connected using CAT5e or better cabling ter-
minated using 8P8C connectors using the T568B standard. Once the modules are networked together,
proceed to Configuration Setup on page 37.

Copyright © TekTone Sound and Signal Mfg., Inc. All Rights Reserved IL1024 Tek-CARE160 Installation Manual | 35

Installation



Installation

Figure 23 - NC415G3 Master Station Wiring and Terminating Resistors
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Configuration Setup
Once hardware installation is complete, set up the system configuration. The LS450 ConfigTool is used to
configure the system, and is installed on the technician’s programming laptop.
To begin setting up the system configuration, ensure that the NC160 CE Modules are powered on, uniquely
addressed, and networked together.

Connect the LS450 ConfigTool Programming Software
In order to connect to the NC160 CE Modules, the IP address of the computer used for programming must
be on the same subnet as the NC160 CE Modules. Set the static IP of the laptop to be 192.168.1.178.
Next, connect a standard Ethernet patch cable between the programming computer and the networked CE
modules.

About Points
The most important concept of the Tek-CARE160 system are the points on the LI122UN and PM120 Room
Controllers. The points are the six physical connections on the rear of each controller, shown as points 1-6
in the configuration. In addition to the physical points, there are also two additional points present in the
configuration, one for the red dome LED and one for the white dome LED.
By default, all of the room controller points are assigned to a Station ID in the ConfigTool. The physical
address of the room controller determines which Station ID points are assigned by default. In the example
below, notice that points 1-6 on the controller with Address 0 on Port 0 of Module 1 are assigned to Sta-
tion 0100 by default.

Figure 24 - Points in the LS450 ConfigTool

NOTE: In order to assign points on a single controller to multiple stations, an LS450 Con-
figTool Plus or LS450 ConfigTool Elite license is required.
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A Tek-CARE160 point can be in three states.
Detectable:When points are in the Detectable state, the central is constantly polling those points, search-
ing for attached stations. If a station is detected, the system assumes that the station type conforms to the
standards found in Connect Stations on page 1.
Exists: If a point is marked as Exists, the point is supervised and the system assumes that a station is con-
nected to that point. If a station goes missing or is not detected, a fault will annunciate for that point.
Disabled: If a point is marked as Disabled, the system does not look for station attachment at the point.

Configuration Methods
There are two ways to set up a Tek-CARE160 configuration. The first and simplest method requires sta-
tions to be wired to the room controllers as shown in Connect Stations on page 1. If all stations are con-
nected to their room controllers on the default points, then the room controllers and stations installed on the
system can be automatically detected and put into use. The only required programming in this instance is
system customization. This scenario will be referred to as an Autodetect Setup.
The second method is used when custom wiring is required because multiple stations that create the same
type of call are connected to a single room controller. Custom wiring scenarios include facilities that have
three or more beds per room (requiring multiple SF121 Single Patient Stations and/or SF122 Dual Patient
Stations per room) or in an area where two or more Code Blue or Emergency switches are connected to the
same room controller. This scenario will be referred to as a Custom Setup.

NOTE: Custom Tek-CARE160 installations require a Plus or Elite license for the LS450
ConfigTool.

Please refer to IL855 LS450 ConfigTool manual for more information and further instruction on how
to use the LS450 ConfigTool.

Configure an Autodetect Configuration
Before beginning system programming, perform a complete test of the system. Ensure that calls annunciate
at the expected LI122UN Room Controllers and that call type annunciation from SF123 Customizable 2-
Button Pull-Cord stations are correct.
Start the LS450 ConfigTool software. On the splash screen, choose the IP address of the Tek-CARE160 sys-
tem on the left and select Load Configuration from System on the right. The default configuration will be
loaded into the LS450 ConfigTool software.

Figure 25 - Config Tool Splash Screen

Next, choose File>Save Configuration As, choose a descriptive file name, and save the configuration.
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Enabling and Naming Modules
Navigate to theModules page. In theModules list, verify that all of the installed NC160 CE Modules
installed on your system are marked as existing.
Note that the number in the Modules list corresponds to the DIP switch address of the CE modules.
If desired, add Location for the module. To add a location for a module, select a module from the list and
click the Edit button to unlock the Details pane for editing. Type a location into the Location field, and
click the Apply button.

Repeat this process for each module installed on the Tek-CARE160 system. If a Tek-CARE server is
installed, scroll to the bottom of theModules list and enable the NC475 Module.

Changing Station Names
Next, change the default station names to names that make sense for the facility.

NOTE: The default station names are a combination of the CE module address, the port
number that a room controller is connected to, and the DIP switch address of the room con-
troller. The CE module address provides the first two digits of the default station name (01-
75), and the address of the room controller provides the second two digits (00-63).

If the room controller is connected to port 0A or 0B, only the address of the room controller is used. If the
room controller is connected to port 1A or 1B, add 32 to the address of the room controller to obtain the
last two digits of the default station name.
For example, a room controller addressed as 12 connected to port 0A or 0B of CE 01 would be assigned a
default station name of 0112. If the same room controller (address 12) were connected to port 1A or 1B of
CE 02, it would be assigned a default station name of 0244.
Using the notes generated during system installation, change the default stations names to those desired by
the facility.
Begin by selecting Stations in the page selection pane of the ConfigTool software. Choose the first station
you wish to edit, then click the Edit button in the upper right corner of the Stations pane. The pane will
unlock for editing.
Select the default station name and delete it. Type a new name in place and click Apply.
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Repeat for all remaining stations to be customized.

Edit Stations
Occasionally, depending on system requirements, some changes will need to be made to the default sta-
tions. Most commonly, SF122s may have been installed on point 1 of the facility’s room controllers,
PM123s may need to be set up as Aux Input 1, Aux Input 2, or Aux Check In functions using the Func-
tions drop-down menu, or SF123s may need to be programmed as reset buttons using the Function drop-
down menu.
Select Points in the page selection pane of the ConfigTool. Click Edit Multiple in the details pane to open
the Edit Multiple window.
Referring to the completed programming worksheet created during installation, select the stations to be
edited. Choose a group of stations that are wired the same way. If there are multiple wiring configurations
on the system, break the stations into groups, e.g., Wiring Configuration A, B, C, etc. Select all of the wir-
ing configuration A stations and edit them, then select all of the wiring configuration B stations and edit
them, etc. Once the edit multiple window is open, select the Station IDs to be edited.
Once stations are selected, enable the points that have stations connected and choose the correct station type
and behavior. Mark any unused points as disabled.
Ensure that both the Red/Blue and White domes are marked as Exists. Select LI122_R if the room con-
troller has red LEDs or LI122_B if the room controller has blue LEDs. If the station must be set up as a
duty station or a zone light, change the behavior of the red/blue and white domes to Red or Blue Zone
Dome and White Zone Dome respectively. This will enable the Station ID to watch zones on the system
and annunciate a call when needed.

IMPORTANT: The LED colors in the ConfigTool MUST match the color that has been
selected on the LI122UN Room Controller.

The Single Bed, Dual Bed, and Duty/Zone buttons at the bottom of the Edit Multiple window can be
used to quickly set up the default station connection points.
Ensure that the Assigned Station Exists box is checked. This will automatically enable the Station ID selec-
ted and simplify future editing.
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Once all selections have been made, click the Apply button. Repeat the edit multiple process for all wiring
configurations.
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Zoning Stations
To place stations in zones, select Zones in the page selection pane of the ConfigTool. Select a zone for edit-
ing and click the Edit button.

Figure 26 - Set Up Zoning and Annunciation

Rename the zone with a descriptive name that makes sense for the facility.
In the Stations pane, select the stations to be included in the zone.
In the Annunciation Locations pane, select where to annunciate the calls from the stations in the selected
zone.
Click Apply to save your changes. Repeat for all zones required by the facility.
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Room Level Reset
SF123s can be programmed as Reset Buttons to enable the room level reset and check in features. With the
SF123 programmed as a reset button, the upper button on the station becomes inoperable. When the lower
button is pressed, any calls annunciating from the same Station ID that the SF123 Reset Button is assigned
to will be automatically reset.
SF123 Reset buttons are not automatically detected by the system on start-up. Refer to the Edit Stations
section for information on setting up SF123 Reset Buttons.
For example, an LI122UN Room Controller connected to NC160 CE Module 1, Port 0, has its DIP switch
address set as 0. By default, the dome light and all devices connected to that controller are assigned to the
default station 0100. The table below shows the devices connected to the room controller.

Point 1 Point 2 Point 3 Point 4 Point 5 Point 6
Device SF122 Routine SF123 Code SF123 Bath None None SF123 Reset
Station 0100 0100 0100 0100 0100 0100

The SF123 Reset Button will reset all calls from a station simultaneously. In the table above, if the SF122,
SF123 Code, and SF123 Bath were all in alarm at the same time, a single press of the SF123 Reset Button
would reset all calls from Station 0100 simultaneously.

Check In
If the facility uses SF123 stations set up as Check In/Reset stations or PM123 Aux Input Modules as Aux
Check In Devices, check in times must be added to the system for the check in feature to function. A
check in time is a time period during which the system expects to see a check in input triggered. If the
check in input is not triggered during the scheduled time period, an Inactivity call annunciates on the sys-
tem. Create several check in times so that each patient can be assigned a check in time that coincides with
their normal waking schedule. Patients can also be assigned one check in time for weekdays and another for
weekends. The table below illustrates some sample check in times.

Start Time End Time Week Days
5:00 6:00 SMTWTFS
6:00 7:00 SMTWTFS
7:00 8:00 SMTWTFS
7:00 8:00 MTWTF
8:00 9:00 S......S

Create Check in Times

1. Click on the Check In tab in the ConfigTool.
2. Click on the Add button in the Check In Times area.
3. Using the 24-hour military time, enter a Start Time and an End Time in the Details area. Midnight

is 0:00. Start and End times must be at least 10 minutes apart.
4. Use the checkboxes to select which days of the week this event is scheduled.
5. Click the Apply button.

NOTE: A single time period cannot cross midnight into the next day. Divide it into two
time period entries. For example, create these two entries to create a scheduled time period
of 6:00 PM Friday to 10:00 AM Saturday:

Begin - 18:00 End - 23:59 Day - Friday
Begin - 0:00 End - 10:00 Day - Saturday
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Editing Master Stations
If desired, the default names of the master stations (e.g., 01M1) can be changed to a more descriptive name.
To do this, navigate to theMasters page in the LS450 ConfigTool.
With the master stations powered on, touch theMenu button on the screen of the NC415G3 or NC404TS
Master Station. Select the Info button from the menu that appears, and note the device name (e.g., 01M1)
that has been assigned to the master station.

Figure 27 - Master Configuration Page

SelectMasters from the page selection pane of the ConfigTool. In the list of masters that appears, select
the master to be renamed.
Click the Edit button to unlock the Details pane for editing. In the details pane, give each master a unique
descriptive name.
If desired, the details pane can also be used to set up call filtering and zones watched for the master. The
Call Filter determines what call types the master station displays and the Zone filter determines which
zone’s calls annunciate on the selected master station. Choose Tone Silence Enabled to silence the tone for
that master.
Once all changes have been made, click the Apply button.
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Disable Detectable Points
Once basic setup is complete, disable the unused points on the system. This lightens the load on the NC160
CE Modules and allows for faster alarm transmission. If unused points are not disabled, the CE module will
continuously poll all detectable points for station connection.
To disable all detectable points, select Points in the page selection pane of the ConfigTool. In the Details
pane, click the gray Disable All Detectable button. A warning will appear noting that this action cannot be
undone. Click OK.
For an autodetected system, configuration is now complete. Choose File>Save Configuration and then
choose File>Commit Configuration to System.

Configure a Custom System
Use the following set of instructions to program the system if custom wiring is used.
Start the LS450 ConfigTool software. On the splashscreen, choose the IP address of the Tek-CARE160 sys-
tem on the left and select New Default Configuration on the right. The default configuration will be
loaded into the LS450 ConfigTool software.

Next, choose File>Save Configuration. Choose a descriptive file name, and save the configuration.
Refer back to Configure an Autodetect Configuration on page 38 to enable and name modules and
points.

Set up Room Controller Points
Once the modules have been edited, it is time to enable the points that the stations are connected to.
Refer to the completed programming worksheet that was created during system installation to ensure cor-
rect programming.
The most important concept to remember during system configuration is the relationship between points
and Station IDs.
The most common scenario is a one-to-one association. For example, a room controller that has been given
the address 1 on its DIP switches would be installed outside of room 101. Any stations in the room would
be connected to the appropriate points on the rear of the room controller.
There are two steps for setting up points. First, edit each Station ID using the Edit Multiple window, then
change station assignments if necessary.

Select Points in the page selection pane of the ConfigTool. Click Edit Multiple in the details pane to open
the Edit Multiple window.
Referring to the completed programming worksheet created during installation, select the default stations to
be edited. Select a group of stations that are wired the same way.
If there are multiple wiring configurations on the system, break the stations into groups, e.g., Wiring Con-
figuration A, B, C, etc. Select all of the wiring configuration A stations and edit them, then select all of the
wiring configuration B stations and edit them, etc.
Once the edit multiple window is open, select the Station IDs to be edited. Once stations are selected,
enable the points that have stations connected and choose the correct station type and behavior.
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Ensure that both the Red/Blue and White domes are marked as Exists. Select LI122_R if the room con-
troller has red LEDs or LI122_B if the room controller has blue LEDs. If the station must be set up as a
duty station or a zone light, change the behavior of the red/blue and white domes to Red or Blue Zone
Dome and White Zone Dome respectively.
This will enable the Station ID to watch zones on the system and annunciate a call when needed.
The Single Bed, Dual Bed, and Duty/Zone buttons at the bottom of the Edit Multiple window can be
used to quickly set up the default station connection points.
Ensure that the Virtual Station Exists box is checked. This will automatically enable the Station ID selec-
ted and simplify future editing.
Once all selections have been made, click the Apply button. Repeat the edit multiple process for all wiring
configurations.

For information on room level reset, check in, editing stations, zoning stations, and disabling points refer
back to Configure an Autodetect Configuration on page 38.

Secondary Dome Annunciation
If desired, calls from one station may be forced to annunciate on the dome light of another station. The
dome light set up as the secondary annunciator must be on the same module as the primary annunciator.
To choose a dome light to serve as a secondary annunciator, navigate to the primary station in the Stations
page. Select the desired secondary dome annunciation station from the drop-down menu.
Repeat for all remaining stations requiring secondary dome annunciations.

Move Points to Stations
Occasionally, it may be necessary to assign a point to a different station than it is defaulted to. To move
points between Station IDs, select the point to be moved from the points list, then click the Edit button.
From the assigned Station menu, select the Station ID and click the Apply button.

Editing Hardware Behaviors
By default, the Tek-CARE160 system generates Routine calls from SF121s and SF122s, and Code, Bath,
Emergency, and Emergency 2 calls from SF123s, depending on the function selected in the points list.
PM123s will generate Aux Input 1 or Aux Input 2 calls by default.
To change the type of call generated, select Behaviors in the page selection pane of the ConfigTool. Click
the Edit button in the Details pane to unlock it for editing.
The call types generated by various inputs on the system can be edited on the hardware page shown in Fig-
ure 28 on page 47. Escalation may also be set for SF121s and SF122s.
For PM123s, note that Aux Input 1 and Aux Input 2 calls follow the position of the monitored switch.
When the normally open switch is closed, the selected call is placed, and when the switch opens again, the
call automatically clears.
To program a PM123 with latching calls that must be acknowledged from a master station, use the selec-
tions for Aux Input 1A/1B Acknowledged. This will trigger a call when the switch closes, and the call will
remain latched in the system until it is acknowledged, regardless of the position of the switch.
Note that any changes made to the Virtual Station Default behavior are global.
Click Apply once all edits are made.
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If a single Station ID on the system requires different call types, create a copy of the Virtual Station
Default behavior using the Add Copy button in the Hardware Behaviors pane. Choose a new name for
the hardware behavior and edit the call types as desired. Click Apply to save the new hardware behavior.
To assign the new behavior to a Station ID, click Stations in the page selection pane. Select the Station ID
that the new hardware behavior is to be assigned to and click the Edit button in the Details pane. Select the
hardware behavior to be assigned to the station from the Behavior: drop-down list and click Apply. Calls
generated by the Station ID that was edited will now generate call types according to the assigned hardware
behavior.

Figure 28 - Behavior Details
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Edit Call Types
For most installations, the standard call types will not require editing. However, installations utilizing
LI122UN dome lights must modify any call types used in the facility to ensure proper annunciation.

Figure 29 - Call Types List

Select the call type to modify from the Call Types list shown above and click the Edit button.

Figure 30 - Dome Light Color Selection

In this section, the Blue selection determines the flash rate of the blue LED on all LI122UNs. The Red
selection determines the flash rate of the red LED on all LI122UNs. In this example, we are editing the
dome light annunciation for the Emergency call type. Note that the settings shown above would result in a
medium flash rate on the red LED of LI122UNs zoned to display the Emergency call, however, any
LI122UNs zoned to display the call would not annunciate the Emergency call, since the selected flash rate
is Off.
Choose the appropriate annunciation settings for the selected call type and click Apply. Choose File>Save
Configuration before proceeding.

NOTE: If dome light annunciation colors are altered, perform a careful walk-through test of
the dome light annunciation to ensure that the correct lights illuminate for the desired call.
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Audio Adjustments
Once installation and configuration are complete, adjustments can be made to change or improve the
volume and quality of the audio on the Tek-CARE160 system.
There are basically three adjustments that can be made by installers to affect the audio of the system.
Speaker volume and microphone gains can be adjusted for each station using the LS450 ConfigTool soft-
ware, and there is an audio trim pot for each audio bus port.
Audio Trim Pot
The audio bus of the Tek-CARE160 system, like any other audio system, is susceptible to electronic noise
induced by other building systems. Most of this noise can be removed by use of the trim pots on each audio
bus port.
In order to reach the trim pots, a very small flathead screwdriver (1/16" blade) is required. There is one trim
pot per audio bus port. They are illustrated below.

Figure 31 - Audio Trim Pots

o Connect an NC415G3 directly to the NC160 CE module using a short patch cable. You must be
able to reach both the NC160 CE module and the NC415G3 Master Station at the same time during
this procedure.

o Dial a Station ID that is connected to Port 0 from the NC415G3 Master Station, and establish an
audio connection using the Talk button, not the handset, of the NC415G3.

o Release the TALK button. You should now have an open audio channel, and be listening to the sta-
tion you dialed through the speaker on the NC415G3.

o Using your flathead screwdriver, turn the potentiometer for Port 0 approximately 12 turns clock-
wise. This ensures that the potentiometer is maxed out. Note that the potentiometer will not stop at
the end of its travel, but will spin freely. This is normal.

o With the potentiometer fully clockwise, you may hear a considerable amount of background and
data noise on the open audio channel. This is normal.

o Begin turning the potentiometer counterclockwise. After six full rotations, the potentiometer will be
in the center of its travel.

o Make small clockwise and counterclockwise adjustments to the potentiometer while listening to the
audio connection. Too far clockwise, and you will induce noise on the audio bus. Too far coun-
terclockwise, and you will induce noise.

o Adjust the potentiometer so that the noise level on the channel is as low as possible. Remove your
screwdriver from the potentiometer and clear the audio connection.

o Finally, dial a Station ID that is connected to Port 1 from the NC415G3 Master Station. Repeat the
process outlined above while adjusting the audio trim potentiometer for Port 1 of the NC160 CE
module.
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Station Volume and Gain Adjustment
Before adjusting the volume and gain of a station, perform a complete system test and check the audio qual-
ity of each room. This will require two people, one in the room, and one at a master station.

o Place a call from the room, and answer the call at the master station, either with the handset or the
push-to-talk button.

o Once the call has been answered, have a brief conversation between the room and the master sta-
tion. If the IR160 in the room produces adequate volume, and the return audio from the station is sat-
isfactory at the master station, continue with the test.

o If audio is too quiet in the room, note the Station ID before moving on so that it can be adjusted
later. The volume of the IR160 is controlled by the Speaker Volume setting in the ConfigTool.

o If audio from the station is too low at the master station, try turning the volume up on the screen of
the master station. If the audio is still too quiet, note the Station ID. We can edit theMic Gain set-
ting in the ConfigTool to improve audio in this direction.

o Continue the walk test of the facility, and note any problem areas for adjustment.
Once all of the stations have been tested for audio volume, we can adjust them as needed using the LS450
ConfigTool software.
Start the software on your laptop that is connected to the NC160 CE module, and select Load Con-
figuration from System at the splashscreen. The configuration you set up earlier should open.
Once the configuration is loaded, select the Stations page in the ConfigTool. Select the Station ID you
wish to edit, and click the Edit button in the Details pane to unlock it for editing.

Figure 32 - Station Audio Adjustment

On the far right of the Details pane, note the Audio Settings section.
Disregard the Duplex setting. It is not used on the Tek-CARE160 system.
To affect the audio in the room, adjust the Speaker Volume up or down.
To affect the sensitivity of the IR160 microphone, adjust theMic Gain up or down.
Make small, incremental changes to the values as needed. Once the changes have been made, select the
Apply button, choose File>Save Configuration and then File>Commit Configuration to System to write
the changes to the system.
Once the changes have been committed, test the station audio again, and if needed, adjust further.
Repeat this process for any other Station IDs that require audio adjustment.
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Placing and Resetting Calls
Residents or patients may place calls on the Tek-CARE160 system by pressing the CALL button on SF121
and SF122 stations, or by pulling the call cord or pressing the CALL button on a SF123 station. Third
party contacts attached to PM123 Aux Input Modules also trigger calls. When a call is placed, the red LED
on the face of the station will flash.
When a call is placed, the call annunciates on the LI122UN Room Controllers, master stations, multicolor
zone lights, mobile devices, or other annunciation locations to which it is assigned.
To talk to the station that placed the call, simply lift the handset and begin speaking. If you wish to use the
push-to-talk feature of the NC415G3, press and hold the TALK button on the NC415G3 Master Station.
Release the TALK button to listen. Picking up the handset will automatically answer the first call in the
list. If more than one call is displayed, touch the call you wish to answer to select it before lifting the hand-
set or pressing the TALK button.
Depending on system programming, some low-priority calls can be silenced or reset from the master sta-
tion. If this option is available on your system, the gray buttons on the right side of the NC415G3 housing
are used. The buttons are labeled accordingly.

Please refer to IL1068 Tek-CARE Master Station User Guide for more information and further
instruction on how to use the various master stations for the Tek-CARE System.
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